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ВВЕДЕНИЕ 

В соответствии с учебным планом студенты третьего курса на-
правления подготовки 38.03.05 «Бизнес-информатика» изучают дисцип-
лину «Бизнес-аналитика на основе больших данных».  

Визуализация и разведочный анализ данных – базовые методы биз-
нес-аналитики, основанной на данных, вне зависимости от их объема.  

Целью учебно-методического пособия является рассмотрение гра-
фических методов представления данных, их возможностей для анализа 
данных и извлечения знаний. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 5

1 РОЛЬ ДАННЫХ В БИЗНЕС­АНАЛИТИКЕ 

1.1 Business analysis body of knowledge (BABOK) 

В текущей практике, если опираться на BABOK, бизнес-анализ  
и бизнес-анализ в IT выступают как синонимичные понятия.  

Задачи бизнес-аналитики: 
– выявление потребностей; 
– обоснование изменений; 
– разработка решений. 
В третьей версии BABOK акцент сделан на изменениях. Улучше-

ния в организации реализуются за счет контролируемых изменений, ко-
торые удовлетворяют потребностям заинтересованных лиц и позволяют 
достигать поставленных целей. Центральные идеи стандарта BABOK – 
шесть ключевых понятий, которые необходимо учитывать при бизнес-
анализе в организации (рисунок 1.1). 

 

 
 

Рисунок 1.1 – Ключевые понятия BABOK 
 

Во главу модели поставлены  «changes» – «изменения», т.е. преоб-
разования деятельности организации для повышения производительно-
сти (эффективности). 

Изменения вызываются «needs»  – «потребностями»  – это пробле-
мы и возможности, которые мотивируют действовать заинтересованных 
лиц, изменяют ценность продукта (услуги), разрушая или повышая ее. 
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Потребности требуют «solution» – «решения», выбора способа дей-
ствовать, удовлетворяющего потребностям заинтересованных сторон  
и учитывающего контекст.  

Изменения инициируются «stakeholder» – «заинтересованной сто-
роной» на основе имеющихся потребностей, влияющих на выбор реше-
ния и воздействующих на изменения.  

Критерием отбора решений и проведения изменений выступает 
«value» – «ценность», потенциальная или реализованная стоимость, зна-
чимость или полезность для удовлетворения потребностей заинтересо-
ванных сторон в конкретной ситуации (контексте). 

Выбор решений и изменения учитывают «context» – «контекст», 
обстоятельства окружающей среды, которые влияют на понимание ре-
шений и изменений.  

BABOK выделяет следующие стадии анализа: 
– понять текущее состояние КАК ЕСТЬ; 
– определить будущее состояние КАК ДОЛЖНО БЫТЬ; 
– определить действия по переходу от «как есть» к «как должно 

быть». 
Бизнес-анализ напрямую связан с бизнес-архитектурой компании, 

бизнес-процессами и IT-решениями для их поддержки. Одной из важ-
ных составляющих бизнес-анализа является анализ данных. Управление 
чем-либо возможно на основе измеримых показателей, которые как раз 
и позволяют на основе исторических данных понять – как есть, опреде-
лить как должно быть и выработать программу планового изменения 
показателей на основе выявленных зависимостей между ними для дос-
тижения этих значений. 

Благодаря текущему мониторингу данных можно отслеживать эф-
фективность принятых решений и корректировать программу измене-
ний, своевременно реагируя на динамично меняющийся контекст.  

В BABOK определяются пятьдесят методов бизнес-анализа, но  
в бизнес-аналитике на основе данных акцент будет сделан на четырех  
из них: 

– Data Mining («Интеллектуальный анализ данных»); 
– Data Modelling («Моделирование данных»); 
– Data Dictionary («Словарь данных»); 
– Data Flow Diagrams («Диаграммы потоков данных»). 

1.2 Наборы данных для анализа. Открытые данные 

Для выработки решений необходимо знать контекст. В отслежи-
вании текущего контекста эффективны BI-системы (англ. business 
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intelligence), которые обрабатывают большие массивы данных, регист-
рируемых в цифровой форме.  

На сегодняшний день существует тенденция бесплатного и сво-
бодного раскрытия цифровых данных как со стороны государства, так  
и со стороны бизнеса.  

Организуются конкурсы или хакатоны по анализу данных 
(hackathon – первоначально соревнование разработчиков-программи-
стов, на текущий момент любых разработчиков, связанных с цифровыми 
решениями):  

 Kaggle – площадка, на которой различные компании проводят 
спортивные соревнования по анализу данных (построение прогнозных 
моделей на близких к реальным данными)  https://www.kaggle.com/; 

 «Лаборатория Касперского» проводит хакатоны по анализу дан-
ных, посвященные индустриальной безопасности; 

 хакатоны от «Сбербанка» по blockchain, machine learning,  big 
data; 

 холдинг «Газпром-Медиа» проводит свой первый хакатон Hack 
The Media в 2018 г., цель которого найти новые идеи и решения по об-
работке огромного массива медиаданных. 

И это только малая часть возможностей попробовать свои силы  
в анализе реальных данных, получить практический опыт использования 
современных инструментов  и платформ анализа.  

В реальном бизнесе данные составляют значительную часть кон-
курентных преимуществ, а значит, являются коммерческой тайной. Та-
кие данные не будут публичными и результаты обработки таких данных 
останутся собственностью компании с ограниченным доступом.  

Для учебных целей в бизнес-аналитике используются публичные 
данные. В них включаются открытые данные и разделяемые данные. 

Существует масса способов объявления статуса данных и откры-
той информации: при распространении открытого программного кода 
часто используются лицензии GPL (General Public License), LGPL, ли-
цензия FreeBSD, лицензия Apache. Для данных разработаны специаль-
ные лицензии, одна из этих лицензий Оpen Database Commons (ODBC) 
разработана Open Knowlage Fondation и лицензия, которая сейчас стано-
вится все более общепринятой, это Creative Commons Zero, это послед-
няя версия лицензии Creative Commons, которая фактически позволяет 
использовать данные для любых целей, в том числе коммерческих. 

Последний вариант помогает компании также в налаживании со-
циальных связей, завоевании репутации и формировании канала подбо-
ра сотрудников, которые до начала официального найма доказали свою 
полезность компании. 
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Данные, которые публикуют коммерческие организации, удовле-
творяют обычно не всем условиям открытых данных. Такие данные  на-
зывают «разделяемые». 

Публикатор разделяемых данных не обязан делиться всеми под-
робностями получения данных. Однако он позволяет воспользоваться 
накопленным объемом цифровых данных третьей стороне, не неся ника-
кой ответственности за то, что эти данные могут оказаться не действи-
тельными, некорректными. Публикатор не обязан поддерживать данные 
в актуальном состоянии. 

Существует несколько площадок, на которых известные компании 
публикуют кейсы вместе с данными для их решения. Такой площадкой 
является, например, https://www.kaggle.com. 

Сайт «Открытые данные в России» предоставляет доступ к анно-
тированным наборам данных, многие из которых удовлетворяют усло-
виям открытых данных (http://data.gov.ru/opendata). 

Сайт Евростата (Eurostat) предоставляет доступ к очень обширной 
статистике по странам Европы и регионам (http://ec.europa.eu/eurostat/ 
data/database). 

Сайт Международного банка (World Bank) предоставляет доступ  
к данным по различным странам (http://databank.worldbank.org/data/ 
home.aspx). 

Сайт Организации экономического сотрудничества и развития 
(Organisation for Economic Cooperation and Development – OECD) публи-
кует данные об экономических и демографических показателях, входя-
щих в нее развитых стран (stats.oecd.org). 

Сайт «Европейское социальное исследование» (European Social 
Survey ESS) предоставляет доступ к данным  сравнительного  исследова-
ния изменения установок, взглядов, ценностей и поведения населения 
Европы, для анализа можно использовать данные восьми волн 2002, 
2004, 2006, 2008, 2010, 2012, 2014 и 2016 гг. (http://www. 
europeansocialsurvey.org/data/). 

1.3 Язык программирования R.  
Среда разработки RStudio 

Для анализа данных будем использовать язык R, который наряду  
с Python активно используется для решения задач анализа данных. 

В учебно-методическом пособии рассматривается версия R version 3.4.2 
на 2017-09-28. Но изменения происходят достаточно оперативно  
и на  2018-03-15 актуальна version 3.4.4. 
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Для установки необходимо загрузить последнюю версию R с сайта 
https://cran.r-project.org/ (имеются установщики для всех ОС). 

Версия R для Windows поставляется с графической оболочкой 
RGui (рисунок 1.2). 

 

 
 

Рисунок 1.2 – Графический интерфейс RGui  
(окно консоли с приглашением «>» для набора кода) 

 

Графический интерфейс поддерживает три вида окон:  
 консоль, в которой после ввода кода (клавиша Enter) он сразу 

передается на исполнение;  
 редактор скриптов (открывается с помощью меню Файл > Но-

вый скрипт), в котором код набирается, редактируется и при необходи-
мости сохраняется с расширением .R, на исполнение код можно посы-
лать построчно или блоками, предварительно выделив;  

 графические окна, в которых строятся и сохраняются графиче-
ские объекты. 

В базовой установке R имеется некоторое количество предуста-
новленных пакетов. Просмотреть все установленные пакеты можно  
с помощью функции  
library() 

дополнительные пакеты находятся по адресу: https://cran.r-project.org/. 
Замечание: код, который можно набирать в консоли или скрипте  

и запускать на исполнение будет набираться шрифтом Calibri на сером 
фоне. 
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 Параллельно с R рекомендуется установить среду разработки 
(IDE) RStudio, дистрибутив которой можно загрузить по адресу:  
https://www.rstudio.com/. 

Как и язык R, эта среда относится к open source. 
Начальные сведения для работы в RStudio. Начальное окно среды 

разработки представлено на рисунке 1.3: 
 Source editor and data view (редактор кода и обзор данных); 
 R console  (консоль); 
 служебная панель 1: Environment, history and connections окруже-

ние (данные, функции, история команд и доступные внешние ресурсы); 
 служебная панель 2: Files, plots, packages, help and viewer (файлы, 

графики, пакеты, помощь и просмотрщик). 
 

 
 

Рисунок 1.3 – IDE RStudio 
 

В меню Tools > Global options… можно настроить расположе-
ние панелей на вкладке Pane Layout: панели Source, Console только 
поменять местами, а вот вкладки на служебных панелях можно переме-
щать с одной панели на другую по желанию (рисунок 1.4). 

Код предпочтительнее набирать в  панели Source, открыв новый 
файл с помощью меню File > New file > R script. На выполнение код 
посылается комбинацией клавиш CTRL+ENTER или кнопкой в правом 

верхнем углу панели  .  
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Рисунок 1.4 – Настройка панелей 
 

RStudio поддерживает автоматическое завершение кода в окне 
Source при помощи клавиши TAB (рисунок 1.5). Такие подсказки мож-
но получить и при наборе аргументов, если используются ранее опреде-
ленные переменные. 

 

 
 

Рисунок 1.5 – Завершение функции library() с помощью клавиши TAB 
 

Горячие клавиши 
CTRL + 1 – перемещает курсор в окно Source; 
CTRL + 2 – перемещает курсор в Console; 
CTRL + L – очищает окно Console от текста; 
ESC – прерывает вычисления. 
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Открыть существующий файл можно с помощью File > Open или 

кнопки  . Открыть файл, с которым недавно работали, можно с по-
мощью File > Recent Files  или кнопки раскрыть список на панели ин-
струментов (рисунок 1.6). 

 

                 
 

Рисунок 1.6 – Список недавно использовавшихся файлов 
 

В окне Source  есть возможность найти и заменить необходимые 

части текста: с помощью Edit > Find and Replace или кнопки  . 
Объект, внесенный в поле для поиска, будет подсвечен в коде. В сосед-
нем окне Replace можно ввести замену (рисунок 1.7).  

 

 
 

Рисунок 1.7 – Поиск и замена кода 
 

При закрытии RStudio программа предлагает сохранить код в от-
крытых файлах текущей сессии и рабочее пространство (Workspace), ко-
торое включает в себя созданные переменные, историю команд (рису-
нок 1.8). 
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Рисунок 1.8 – Завершение работы RStudio 
 

При открытии RStudio загружается сохраненное рабочее простран-
ство со всеми незакрытыми в прошлой сохраненной сессии файлами, 
созданными переменными, функциями и историей команд. 

Вкладка History (рисунок 1.9), которую можно подключить в одну 
из служебных панелей, содержит журнал всех ранее выполненных в ра-
бочем пространстве команд (в окне Console).  

 

 
 

Рисунок 1.9 – История команд 
 
Команды сохраняются и после очистки окна Console. Эти коман-

ды можно передавать на выполнение в Console кнопкой  ,  
они выполнятся после нажатия ENTER, или скопировать в открытый 
файл в окне Source (если открытого файла нет, то создастся новый) 

кнопкой  . Для работы с несколькими командами их нужно 
предварительно выделить. 

Вкладка Environment (рисунок 1.10), которую можно подключить 
в одну из служебных панелей, содержит описание всех объектов (это 
могут быть пользовательские функции, переменные), которые были соз-
даны ранее в рабочем пространстве. 
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Рисунок 1.10 – Завершение функции library() с помощью клавиши TAB 
 

Текущую рабочую директорию (папку) можно проверить с помощью 
функции  

getwd() 

Файлы текущей рабочей директории отображаются в окне вкладки 
Files (рисунок 1.11) 

 

 
 

Рисунок 1.11 – Файлы текущей рабочей директории 
 

Текущую рабочую папку можно поменять, например, с помощью 
кнопки на вкладке Files (рисунок 1.12) или с помощью меню Tools > 
Change Working Dir... 

 

 
Рисунок 1.12 – Смена рабочей папки 
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Возможные последствия изменения рабочей папки: 
– имеющиеся в коде относительные ссылки на файлы станут не-

действительными; 
– при завершении работы файл .RData будет сохранен в новую 

папку. 
Установка новых пакетов, необходимых в данной рабочей сессии, 

возможна на вкладке Packages с помощью кнопки Install (рису- 
нок 1.13). При наборе имени пакета подключается автозаполнение. 

 

 
 

Рисунок 1.13 – Установка пакетов 
 

Флаг на опции Install dependencies означает, что установятся  
и все связанные пакеты, функции которых использует нужный пакет 
(рисунок 1.14).  

 

 
 

Рисунок 1.14 – Установка всех связанных пакетов 



 16

Установка новых пакетов возможна и с помощью команды, аргу-
менты которой – это имя пакета и значение true для переменной de‐
pendencies, чтобы установились связанные пакеты: 

install.packages('ggplot', dependencies = T) 

Установленные пакеты нужно подключить в текущей рабочей сес-
сии, чтобы можно было использовать определенные в них функции  
и имеющиеся в пакетах наборы данных. Это можно сделать на вкладке 
Packages, установив флаг на нужном пакете (рисунок 1.15). 

 

  
 

Рисунок 1.15 – Подключение пакета в текущей сессии 
 

Или с помощью команды 

library(ggplot2) 

Но подключение пакета с помощью команды не гарантирует, что 
такой пакет уже был установлен (и подключение не выполнится), тогда 
как в первом варианте недоступные для подключения пакеты просто  
не отображаются. 

На вкладке Help можно получить справку по пакетам, функциям, 
наборам данных и т.п. (рисунок 1.16). 

 

 
Рисунок 1.16 – Справка по функции library()  



 17

Или с помощью знака вопрос перед объектом для получения о нем 
справки: 
?library() 

На вкладке Plots отображаются построенные в текущей сессии 
графики (рисунок 1.17). 

 

 
 

Рисунок 1.17 – График 
 

На вкладке Plots  (рисунок 1.18): 1 – между графиками можно пе-
ремещаться, 2 – увеличивать размер графика, 3 – сохранять график 
в доступном формате (как рисунок или файл .pdf).  

 

 
 

Рисунок 1.18 – Операции с графиками 
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1.4 Типы данных в R 

Основные типы данных, которые поддерживает язык R: 
 логические данные (logical); 
 вещественные числа (numeric); 
 комплексные числа (complex); 
 текстовые данные или символьные (character). 
Объекты данных: векторы, факторы, массивы, матрицы, таблицы 

данных и списки.  
Присваивание переменной значений с помощью <‐, несколько 

значений передаются с помощью команды c(  ), в которой отдельные 
значения разделяются запятой, а текстовые значения заключаются в ка-
вычки. Комментируется код с помощью #. 

Базовый объект данных в R – вектор. Создание вектора: 

v1 <‐ c(T, F, F) #логический вектор – logical  
v2 <‐ c(3, 4, 8, 9)  #числовой вектор – numeric 
v3 <‐ c("male", "female", "male", "male", "female") #вектор  
символьных значений – character    

После выполнения кода на вкладке Environment  отобразятся все 
три переменные с указанием типа данных элементов вектора (рису- 
нок 1.19). 

 

 
 

Рисунок 1.19 – Переменные (в служебной вкладке RStudio) 
 

Вектор может содержать данные только одного типа (рисунок 1.20). 
Самый общий тип данных – символьный. 

 

   
logical  numbers  character 

Рисунок 1.20 – Векторы 
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Если среди логических значений будет хотя бы одно число, то век-
тор определится как числовой, а если одно из значений символьное, то  
и весь вектор определится как вектор символьных значений (рису- 
нок 1.21): 

v1 <‐ c(T, F, F, 8) #числовой вектор – numeric 
v2 <‐ c(T, F, F, "female") #вектор символьных значений – character 
 

 
 

Рисунок 1.21 – Переменные (в служебной вкладке RStudio) 
 

Частный вид векторной переменной – фактор. Фактор это группи-
рующая переменная. Так переменная v3 может быть преобразована  
в фактор: 

v3.f <‐ factor(v3)  

Можно создать факторную переменную v4, значения которой бу-
дут упорядочены: 

v4 <‐ factor(c("S", "XS", "XXL", "L", "XS"), levels = c("XS", "S",  
"M", "L", "XL", "XXL", "XXXL")) 

Отличие этих факторов в том, что в первом случае числовые метки 
присваиваются при лексикографическом упорядочении (как в словарях), 
а во втором – согласно следованию значений в переменной levels (рису-
нок 1.22). 

 

 
 

Рисунок 1.22 – Факторы (в служебной вкладке RStudio) 
 

Матрица – это частный случай массива (двумерный массив), как,  
впрочем, и вектор – это одномерный массив. На матрицу также накла-
дывается ограничение на тип значений: у всех значений в матрице один 
тип данных (рисунок 1.23). 

 
Рисунок 1.23 – Матрица 
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Создание матриц: 

n <‐ matrix(c(1, 7, 3, 4, 8, 1), nrow = 2, ncol = 3) 
l <‐ matrix(c(1, 7, 3, 4, 8, "1"), nrow = 2, ncol = 3) 

Результат во вкладке Environment (рисунок 1.24). 
 

 
 

Рисунок 1.24 – Матрицы (в служебной вкладке RStudio) 
 
Массив в практике анализа данных используется достаточно редко, 

у всех значений в массиве – один тип данных (рисунок 1.25). 
 

 
 

Рисунок 1.25 – Массив 
 

Создание массива, где аргумент dim задает размерность (три мат-
рицы размерности 2*2), а имя переменной вызывает ее содержимое  
в консоль: 

ar<‐array(data=1:12, dim=c(2,2,3)) 
ar 

Результат выполнения кода в Console (рисунок 1.26). 
 

 
Рисунок 1.26 – Вывод значений созданного массива ar в консоль 
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Таблица данных или двумерный набор данных встречается в ана-
лизе данных особенно часто. Колонки в таблице могут иметь различный 
тип данных, но в пределах одной колонки (столбца) – все данные одного 
типа  (рисунок 1.27). 

 
 

Рисунок 1.27 – Таблица данных 
 

Создание таблицы данных: 

sale<‐data.frame(IDcustomer=c(1101, 1102, 1105), gender= 
c("male", "female", "male"), Totalsum=c(18000, 1920, 1078)) 

Результат выполнения кода во вкладке Environment (рисунок 1.28). 
 

 
 

Рисунок 1.28 – Таблица данных sale 
 

Также таблицу данных можно отобразить в окне Source, щелкнув 
по имени таблицы данных во вкладке Environment (рисунок 1.29). 

 

 
 

Рисунок 1.29 – Таблица данных sale 

1.5 Импорт данных в R 

Язык R имеет множество возможностей для импорта данных  
из самых разных источников. Кроме того, устанавливаемые пакеты так-
же содержат наборы данных. 
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Рассмотрим встроенные в пакеты наборы данных. В базовой установ-
ке есть пакет datasets, в котором большое количество именованных наборов 
данных. Информацию о наборах данных можно получить по команде: 

library(help = "datasets") 

В результате выполнения кода в окне Source появится список на-
боров данных (рисунок 1.30).  

 

 
 

Рисунок 1.30 – Список наборов данных в пакете datasets 
 

Более подробно о каждом наборе можно узнать во вкладке Help 
(рисунок 1.31). 

 
Рисунок 1.31 – Информация о наборе mtcars 



 23

Передать набор в новую переменную и просмотреть начало таблицы: 

car<‐mtcars 
head(cars) 

Результат выполнения кода в консоли (рисунок 1.32). 
 

 
 

Рисунок 1.32 – Первые шесть строк таблицы данных car 
 

Наборы данных, размещенные на сайтах в сети Интернет, можно 
загружать несколькими способами. Можно предварительно скачать 
файл данных, разместить в рабочей папке и использовать в функции 
read.table() в качестве аргумента file непосредственно имя файла. Можно 
в качестве аргумента file использовать гиперссылку на файл в Интерне-
те. Не все варианты размещения данных позволяют обращаться к ним  
по ссылке, поэтому используем первый способ. 

На сайте Kaggle (https://www.kaggle.com/) необходимо пройти регистра-
цию, после чего станут доступны наборы данных для скачивания (рисунок 1.33). 

 

 
Рисунок 1.33 – Платформа kaggle 

 

Доступны публичные наборы данных (рисунок 1.34), которые от-
фильтрованы по объему (<10 Mb), так как без специальных ухищрений R  
не позволяет напрямую из консоли анализировать большие объемы данных. 

 

 
Рисунок 1.34 – Наборы данных 
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Среди наборов выберем набор https://www.kaggle.com/ulabox/ 
ulabox-orders-with-categories-partials-2017/data (рисунок 1.35). И скача- 
ем его.  

 

 
 

Рисунок 1.35 – Набор данных по заказам  
в супермаркете Ulabox (Испания) в 2017 г. 

 

Далее перенесем его в рабочую папку и сократим название, чтобы 
было легче работать с импортом (рисунок 1.36). 

 

 
 

Рисунок 1.36 – Рабочая директория 
 

Импортируем данные в переменную Orders с помощью функции 
read.table(), аргументы которой имя файла в кавычках (файл в рабочей 
директории), header=T (так как в первой строке заголовки) и sep – раз-
делитель данных (в нашем случае – запятая): 

Orders<‐read.table("ulabox_orders.csv", header=T, sep=",")  

Результат выполнения кода в двух окнах Source и Environment  
на рисунке 1.37. 

 
Рисунок 1.40 – Набор данных Orders 
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Краткое описание импортированного набора данных  
Набор данных онлайн-супермаркета Ulabox 2017, доступ  

из https://www.github.com/ulabox/datasets. Ulabox – это супермаркет  
в Испании. 

Переменные набора: 
 customer: анонимизированный идентификатор клиента; 
 order: ID заказа, начиная с нуля; 
 total_items: количество приобретенных товаров в заказе; 
 discount%: процент от общей полученной скидки; 
 weekday: день недели: 1=понедельник, 7=воскресенье; 
 hour: час дня, когда была совершена покупка от 00 до 23. 
Categories' partials процент денег, потраченных в каждой из восьми 

основных категорий веб-сайта: 
 food%: не скоропортящиеся продукты, например, рис, снеки, со-

усы и т.п.; 
 fresh% : свежие и замороженные продукты, например: фрукты, 

овощи, замороженное мясо и т.п.; 
 drinks% : все виды напитков, например: вода, соки, вино, алко-

гольные напитки, молоко, соевые напитки; 
 home% : товары для дома, от туалетной бумаги до мелкой быто-

вой техники; 
 beauty% : парфюмерия, косметика, уходовые средства; 
 health% : лекарственные средства, которые можно продавать  

в Испании без рецепта врача: диетические таблетки, презервативы, зуб-
ная паста; 

 baby% : товары по уходу за ребенком, детское питание и т.п.; 
 pets% : товары для домашних животных. 
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2  БАЗОВЫЕ ВОЗМОЖНОСТИ ЯЗЫКА R  
ДЛЯ ВИЗУАЛИЗАЦИИ ДАННЫХ 

2.1 Функция plot() 

plot() – основная графическая команда, она распознает тип объекта, 
который подлежит рисованию, и строит соответствующий график.  

Основные аргументы функции plot() 
 main – название диаграммы; 
 pch (plotting character [0:25]) – вид маркера; 
 cex (character extension) – размер; 
 col (colour) – цвет;  
 xlab – название горизонтальной оси; 
 ylab – название вертикальной оси. 
Для  построения графиков скачаем и импортируем набор https:// www. 

kaggle.com/mirichoi0218/insurance – расходы на медицинское обслуживание. 
Описание переменных набора: 
 age: возраст основного бенефициара; 
 sex: пол застрахованного; 
 bmi: индекс массы тела; 
 children: число детей, охваченных медицинским страхованием / 

число иждивенцев; 
 smoker: курит ли застрахованный; 
 region: жилой район получателя в США, Северо-Восток, Юго-

Восток, Юго-Запад, Северо-Запад; 
 charges: индивидуальные медицинские расходы, оплачиваемые 

страховкой. 
Рассмотрим набор данных – расходы на медицинское обслужива-

ние тех, кто имеет медицинскую страховку. Первые строки набора  
на рисунке 2.1. 

 
Рисунок 2.1 – Набор данных insurance 
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Оценим визуально, каковы пропорции женщин и мужчин в наборе. 
Обращение к переменной происходит по имени таблицы до знака $  
и названию столбца после: insurance$sex. 

plot(insurance$sex, main = "Половой состав застрахованных",  
col = c("red","blue")) 

Результат выполнения команды на рисунке 2.2, аргумент main за-
дает заголовок. 

 
 

Рисунок 2.2 – Разделение набора данных по полу 
 

Аналогично проведем оценку пропорций курящих и некурящих  
в наборе данных: 

plot(insurance$smoker, main = "Количество курящих  
среди застрахованных", col = c("green","red")) 

Результат выполнения команды на рисунке 2.3.  
 

 
 

Рисунок 2.3 – Разделение набора данных  
по наличию вредной привычки 
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Проанализируем зависимость индивидуальных медицинских рас-
ходов в зависимости от пола, возраста и наличия вредных привычек. 

Числовые переменные: возраст и расходы – построим на графике. 
Возраст – независимая переменная, она откладывается по оси x и запи-
сывается первой:  

plot(insurance$age, insurance$charges, main = "Медицинские  
расходы", xlab = "Возраст застрахованного", ylab =  
"Расходы") 

Результат выполнения команды на рисунке 2.4, аргумент main за-
дает заголовок, а xlab, ylab – подписи осей. 

 
 

Рисунок 2.4 – Индивидуальные медицинские расходы  
в зависимости от возраста 

 
Очевидно, что с возрастом индивидуальные медицинские расходы 

растут. Но интересно узнать, влияет ли пол или скажем наличие вредной 
привычки на медицинские расходы. 

Изменим цвет точек графика в зависимости от пола с помощью 
функции  ifelse(insurance$sex=="female",  "red",  "blue"), если значение 
пола – женщина, то цвет точек будет красным, иначе – синим: 

plot(insurance$age, insurance$charges, col = ifelse(insurance$sex == "fe‐
male", "red", "blue"), main = "Медицинские расходы", xlab = "Возраст 
застрахованного", ylab = "Расходы") 

И добавим легенду: первый аргумент задает ее расположение 
“top(bottom)right(left)”, второй размер (лучше брать меньше 1, чтобы  
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не перекрывался график), третий вид маркера для точек, четвертый цвет 
точек и последний текст подписей точек в легенде:  

legend("topleft", cex = .5, pch = 1, col = c("red", "blue"),  
c('женщины', 'мужчины')) 

Результат выполнения команд на рисунке 2.5. 
 

 
Рисунок 2.5 – Индивидуальные расходы в зависимости  

от возраста с учетом пола 
 

Визуально разница между индивидуальными расходами мужчин  
и женщин не очень бросается в глаза. Попробуем добавить данные  
о курении, изменив вид маркера для курящих: pch  =  as.numeric  
(insurance$smoker). Необходимо добавить преобразование к числовому 
виду переменной insurance$smoker с помощью функции as.numeric(): 

plot(insurance$age, insurance$charges, col =  
ifelse(insurance$sex == "female", "red", "blue"),  
pch=as.numeric(insurance$smoker), main = "Медицинские  
расходы", xlab = "Возраст застрахованного", ylab = "Расходы") 

И в легенду теперь добавляется вид маркера и дополнительный 
значения подписей точек легенды: 

legend("topleft", cex= .5, c('некурящие женщины', 'некурящие  
мужчины', 'курящие женщины', 'курящие мужчины'),  
pch =c(1, 1, 2, 2), col = c("red", "blue")) 

Теперь наш график имеет совсем подробный вид (рисунок 2.6).  
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Рисунок 2.6 – Индивидуальные расходы в зависимости  

от возраста с учетом пола и вредной привычки 
 

И хорошо заметно, что большее число треугольников сосредоточе-
но в зоне высоких медицинских расходов, а большее число кружочков  
в зоне небольших индивидуальных медицинских расходов. 

Построим аналогичным образом график зависимости медицинских 
расходов от индекса массы тела с учетом пола и наличия вредной при-
вычки: 
plot(insurance$bmi, insurance$charges, col =  
ifelse(insurance$sex == "female", "red", "blue"), pch=as.numeric 
( insurance$smoker), main = "Медицинские расходы", xlab =  
"Индекс массы тела", ylab = "Расходы") 

legend("topleft",cex=.5, c('некурящие женщины',  
'некурящие мужчины', 'курящие женщины', 'курящие мужчины'),  
pch = c(1, 1, 2, 2), col = c("red", "blue")) 

Теперь четко прослеживается, что повышенный индекс массы тела 
при наличии вредной привычки в совокупности существенно повышают 
медицинские расходы, независимо от пола (рисунок 2.7). 

 
 Рисунок 2.7 – Индивидуальные расходы в зависимости  
от индекса массы тела с учетом пола и вредной привычки 
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2.2 Функция boxplot() 

boxplot() – диаграмма размахов или «ящики с усами» (англ. box-
whisker plots) имеет характерный вид ящика включающего в себя 50 % 
серединных значений (между квантилями 0,25 и 0,75). На диаграмме 
размахов также визуально определяется наличие в данных выбросов 
(рисунок 2.8). 

 

 
 

Рисунок 2.8 – Диаграмма размаха 
 

Основные аргументы функции boxplot(): 
 formula – формула, такая как y ~ group, где y – числовой вектор 

значений данных, которые должны быть разбиты на группы в соответст-
вии с группирующей переменной group (обычно фактор); 

 data – набор данных, переменные из которого входят в формулу. 
Построим диаграмму размаха для индивидуальных медицинских 

расходов: 

boxplot(insurance$charges, main = "Медицинские расходы") 

Как видим (рисунок 2.9), в данных довольно много выбросов: это 
тяжелые заболевания у отдельных застрахованных, которые сопряжены 
с очень высокими расходами, нехарактерными для основной части наб-
людений. 
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Рисунок 2.9 – Диаграмма размаха для медицинских расходов 
 
Построим диаграммы размахов по медицинским расходам для двух 

частей выборки, разделенной по наличию вредной привычки. В качестве 
первого аргумента для boxplot() теперь используется функция: слева 
расходы – зависимая величина, справа наличие вредной привычки – не-
зависимая величина, второй  аргумент – имя набора данных:  

boxplot(charges~smoker, insurance, main = "Медицинские  
расходы в зависимости от курения") 

Разница в медицинских расходах между курящими и некурящими 
очень существенная (рисунок 2.10). 

 

 
 

Рисунок 2.10 – Диаграмма размаха медицинских расходов  
для курящих и некурящих 
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Построим диаграммы размаха для медицинских расходов в зави-
симости от количества детей (рисунок 2.11): 

boxplot(charges~children, insurance, main = "Медицинские  
расходы в зависимости от количества детей") 

 

 
 

Рисунок 2.11 – Диаграмма размаха медицинских расходов 
 при различном количестве детей 

 
Построим диаграммы размахов по медицинским расходам для со-

четания двух факторов: наличия вредной привычки и пола. Для этого 
введем в исходный набор данных две новые переменные: sex1 и smoker1,  
в которых запишем вместо исходных значений переменных их метки:  
1 – женский, 2 – мужской и, соответственно, 1 – некурящий, 2 – курящий:  

insurance$smoker1 <‐ as.numeric(factor(insurance$smoker)) 

insurance$sex1<‐ as.numeric(factor(insurance$sex)) 

Далее представим значения этих переменных как факторы двумя 
уровнями, которым соответствуют определенные метки: 

insurance$smoker1 <‐ factor(insurance$smoker1,  
levels=c(1, 2), labels=c("некурящий", "курящий")) 

insurance$sex1<‐ factor(insurance$sex1,  
levels=c(1, 2),labels=c("женский", "мужской")) 

Теперь можно построить график, в котором диаграммы размаха 
для медицинских расходов построены для различных сочетаний значе-
ний: пол и наличие вредной привычки (рисунок 2.12): 
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boxplot (charges ~ sex1*smoker1, insurance, varwidth = TRUE,  
col = c("red","blue"), main = "Индивидуальные медицинские расходы") 

 

 
 

Рисунок 2.12 – Диаграмма размаха медицинских расходов 
 при различном сочетании значений факторов:  

пол и наличие вредной привычки 

2.3 Функция mosaicplot() 

mosaicplot() – это графический метод визуализации данных  
из двух или более качественных переменных. 

Основные аргументы функции mosaicplot() 
 x – таблица сопряженности в виде массива с дополнительными 

категориями, указанными в dimnames(х). Таблицу лучше всего создавать 
командой table (). 

Построим таблицу сопряженности для факторов: пол и наличие 
вредной привычки: 

x <‐ table(insurance$sex, insurance$smoker) 

Таблица сопряженности разбивает все множество наблюдений  
на четыре группы: курящие женщины, курящие мужчины, некурящие 
женщины и некурящие мужчины. Если между этими показателями есть 
связь, то ее наличие можно обнаружить с помощью графического пред-
ставления таблицы сопряженности благодаря применению к таблице 
функции mosaicplot(): 
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mosaicplot(x, color = T, shade = T, main = "Сопряженность  
признаков пол и курение", xlab = "пол", ylab = "курение") 

На рисунке 2.12 видно, что связи между этими показателями нет, 
хотя среди женщин, застрахованных в компании, меньший процент ку-
рящих, чем среди мужчин. 

 
 Рисунок 2.12 – Сочетание в наборе данных признаков:  

пол и наличие вредной привычки 
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3 ВОЗМОЖНОСТИ ПАКЕТА  
GGPLOT2 

Первоначально подключим пакет ggplot2 

library(ggplot2) 

Базовой графической командой пакета ggplot2 является команда 
qplot(). 

Основные аргументы функции qplot(): 
 x, y – переменные набора данных; 
 data – набор данных, переменные из которого входят в формулу; 
 color,  shape,  size,  fill – определяет соответствие цвета, формы  

и размера символов уровням переменной, для диаграмм плотности  
и размахов параметр fill определяет соответствие заполняющего цвета 
значениям переменной; 

  объекты, которые задают тип диаграммы. Этот параметр задает-
ся в формате текстового вектора с одним или более элементами: "point", 
"smooth", "boxplot", "line", "histogram", "density", "bar"и"jitter"; 

 facets – используется для построения категоризованных диа-
грамм: если используются две факторные переменные для разбиения 
набора данных, то между ними ставится ~:  facets =  sex1~smoker1, если 
одна переменная, то либо facets=children~., либо facets= . ~ children; 

 method – можно использовать следующие методы сглаживания 
(параметр formula): "lm" (регрессия), "gam" (обобщенные аддитивные 
модели) и "rim" (устойчивая регрессия). 

Построим точечный график зависимости индивидуальных меди-
цинских расходов от возраста (рисунок 3.1): 

qplot(x = age, y = charges, data = insurance, geom = "point", xlab =  

"Возраст", ylab = "Расходы") 

Построим диаграммы размахов медицинских расходов для куря-
щих и некурящих клиентов страховой компании (рисунок 3.2): 

qplot(smoker1, charges, data = insurance, geom = c("boxplot",  

"jitter"), fill=smoker1, xlab="Наличие вредной привычки", 

ylab="Расходы",main="Диаграммы размахов") 
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Рисунок 3.1 – Точечный график расходов от возраста застрахованного 
 

 
 

Рисунок 3.2 – Диаграммы размахов расходов для курящих  
и некурящих клиентов 

Построим точечные графики для набора данных разделенного  
на выборки в зависимости от сочетания значений факторов: пол и нали-
чие вредной привычки (рисунок 3.3): 
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qplot(age, charges, data = insurance, facets = sex1~smoker1,  
xlab = "Возраст", ylab = "Расходы" ) 

 

 
 

Рисунок 3.3 – Точечный график расходов от возраста застрахованного 
 (в зависимости от сочетания значений факторов:  

пол и наличие вредной привычки) 
 

Построим график плотности (geom="density") распределения рас-
ходов для выборок разделенных по полу (рисунок 3.4): 

qplot(charges, data = insurance, geom="density", facets=sex~., fill=sex,  
xlab = "Расходы") 

 

 
Рисунок 3.4 – График плотности распределения расходов   

(для мужчин и женщин) 
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Построим график плотности распределения расходов для выборок, 
разделенных по количеству детей (рисунок 3.5): 

qplot(charges, data = insurance, geom="density",  
facets=children~., fill=children, xlab = "Расходы") 

 

 
 

Рисунок 3.5 – График плотности распределения расходов   
(в зависимости от числа детей) 

 
Построим две регрессии на одной координатной плоскости (рег-

рессия – это функциональная зависимость между случайными величи-
нами, одна из которых рассматривается как независимая, другая зависи-
мая). Первая регрессия для некурящих, вторая для курящих клиентов 
страховой компании (рисунок 3.6). Очевидно, что медицинские расходы 
у этих групп клиентов существенно различаются (в пользу некурящих):  

qplot(age, charges, data = insurance, color = smoker1,  
shape = smoker1, geom = c("point", "smooth"), method = "lm",  
formula = y~x, xlab = "Возраст", ylab = "Расходы",  
main ="Пример с регрессией") 
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Рисунок 3.6 – Линейные регрессии расходов в зависимости  
от возраста отдельно для курящих и некурящих клиентов 
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4 ЛАБОРАТОРНЫЕ РАБОТЫ 

Л а б о р а т о р н а я  р а б о т а  № 1  
«Визуализация данных: базовая графика» 

Цель работы: научиться импортировать данные и применять  
к ним базовые графические функции языка R для визуализации и вы-
движения гипотез о наличии зависимостей.  

Формируемые знания, умения и навыки: изучить базовые гра-
фические возможности языка R, уметь импортировать данные из дос-
тупных источников. 

Необходимо: 
1. С сайта Kaggle (https://www.kaggle.com/) импортировать один  

из наборов, включающий столбцы с числовыми значениями размером <5 Mb. 
2. Используя базовые графические возможности языка R, провести 

визуальный анализ данных и выдвинуть гипотезы о наличии зависимо-
стей между переменными набора. 

Контрольные вопросы и задания 
1. Какая функция используется для импорта таблиц данных в фор-

мате .csv? Какие аргументы у этой функции? Какие значения могут при-
нимать аргументы этой функции? 

2. Какие аргументы у функции plot()? Какие значения могут при-
нимать эти аргументы? 

3. Какие аргументы у функции legend()? Какие значения они могут 
принимать? 

4. Опишите выбранный набор данных: контекст данных, перемен-
ные из набора, зависимости между переменными, выявленные ви-
зуально.  

Л а б о р а т о р н а я  р а б о т а  № 2  
«Визуализация данных: пакет ggplot2» 

Цель работы: научиться использовать расширенные графические 
возможности, предоставляемые пакетом ggplot2.  

Формируемые знания, умения и навыки: изучить возможности 
визуализации данных для разведочного анализа. 

Необходимо: 
1. На том же наборе данных провести построение графиков с помо-

щью функции qplot()  пакета ggplot2. 
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2. Самостоятельно изучить возможности визуализации данных с по-
мощью функции ggplot()  пакета ggplot2. 

Контрольные вопросы и задания 
1. Какие аргументы могут быть у функции qplot()?  
2. Какие значения может принимать аргумент geom? 
3. Как определяется facet? 
4. Какие значения может принимать method? 
5. Как определяется функция ggplot()? 
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